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SUMMARY

Websites that play a central role in the business strategy are never self -contained. Application
Programming Interfaces (APIs) come standard with GX WebManager. They allow developers to,
in addition to the standard config uration options, adapt an imple mentation to the demand and
connectit to other applications.

The Design API allows determining and modifying the design of a website very easily, using
JSPs.

PREREQUISITES

To use the GX WebManager SDK, the programmer shou Id have the following:

e  Experience with (X)HTML and CSS.

. Experience with script language (e.g., JSP, PHP, ASP). Programming takes place in a
JSP environment, so experience with JSP is an advantage.

e Experience with Java is handy but not required.

The progra mmer should also have completed the GX WebManager basic and advanced training
modules for editors. It is also handy to be familiar with  using WCBs (WebManager Component
Bundles), GX WebManager forms and database connections, butitis not absolutely necess  ary.

RELATED TOPICS

Presentation Services
e Fonts & Styles

Software Develop ment kit
e WCB Development 6 Quick Start
e WCB Development d Tutorial

VERSION CONTROL

| Version Date Description
1.0 February 15, 2008 Initial version
1.01 February 26, 2008 Added document ID on title page
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1 INTRODUCTION

GXWebManager supports separation of design, logic, and content. This document explains how
this separation comes about and where these three areas meet.

This chapter briefly explains how a page in GX WebManager is constructed, what the parts of the
Design SDK are which technologies are involed, and howthey can be used in GXWebManager.

Java Server Pages (JSPs) determine thedesign of GX WebManager pages.JSPs are a way of easily
creating dynamic websites based on the Java standard. From the JSPs, GXWebManager functions
and generally available functions are requested. These functions are part of a) the WebManager

API and b) third party taglibs, such as JSTL for example. These two ways allow adding Business
Logic to the page. They also allow access to the content in GXWebManager. Therefore, JSPs are
the axles between design, logic, and content.

Ty —

..\‘

Editor

Business Logic —

WebManager API + taglibs

&
= ‘

Webmaster

Website visitors

Presentation
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1.1 The GX WebManager APl and JSTL

One of the most important parts of the Design SDK is the GX WebManager Design API. API stands
for Application Programmer Interface and defines the interface between an application and a
service. In the GX WebManager context, the web pages 0 as the end user sees them 0 are the
Oapplicati WweabMandg&K is the O6serviced.

JSPs are made dynamic by adding calls to functions , specified in the GX WebManagerDesign API.
The API is implemented in Java and is requested in a JSP as atag library (aso-called taglib).

Besides the GXWebManager taglib, third party taglibs can be used, such as the JSTL taglibs . JSTL

taglibs, which are frequently used, al |l ow t he wuse of st-ahemént danBaache @s
0f or Eac hd Other functidn$ &e used to format dates, to use locales, and to execute

queries. Additional detail about JSTL falls be yond the scope of this document, but several

tutorials are available online . A handy overview of the most frequ ently used JSTL functions is

available at: http://www.jadecove.com/downloads/jstl -quick -reference.pdf .
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2 DESIGN IN SIX STEPS

This chapter explains in a few steps, how any design/w ebsite can be placed in GX WebManager

and how it can be made dynamic. This is primarily intended to ensure that GX We bMa nager ds page
content is shown in the new design. This chapter will show in a few simple steps, the power of

the GX WebManagerSDK.You may not completely understand all the details immediately after

taking these steps. The detail will be covered inthe next chapter.

Attention : These instructions assume that the person executing them, has access to a locally
installed GX WebManager (or has access to GXWe b Manager ds installation folder
disk).

2.1 STEP 1 06 Collect the HTML

Every project based on GX WebManager requires an HTML version of the website before the design
of the site can be implemented. This step uses this HTML version n such a way that it can be the
starting point for a new presentation of a page in GX WebManager. The static HTML website HTML
is usually provided by the designer, but in this example we start with saving an existing website .

You can choose any website you want, but if this is your first time then you get the best resuls
with a website that is not too complex and with a page that contains an article. Usually this is not

the homepage but an article detail page.

Actions:

= Open Firefox (Firefox saves the we b page better than Internet Explorer).
= Go to a page of the static HTMLwebsite that has to be transferredto GX WebManager.

= Select the Save page as option fromthe File menu.

= Save the page with an appropriate short name, mysite.html , for example.
= A mysite.html file and a mysite _files folder have been created on disk.
The mysite_files folder contains the images, style sheets, and other files that make the page

complete. It is possible that images important to the design are referred to in the style shee t (a
file ending with .css) or in a Javascript file . Firefox does not download these files, so they will
have to be downloaded separately (by requesting them one by one in the browser and saving them
to the folder that contains the other images ( mysite _fil es).
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2.2 STEP 2 06 Create a presentation WCB

In order to deploy your custom presentation to a GX WebManager installation you have to use a

presentation WCB (WebManager Component Bundle). TheWCBis a small .jar (Java A Rchive) file
that contains all your JSPs and static files. Once it is deployed the JSPs and static files are copied

to the right directories inthe GX WebManager installation.

Actions:

= Open an MSDOS prompt in a directory outside your GX WebManager installation directory
where you would like to create your presentation WCB, for example C:\svn\. You
dondt have to cr e at,ée Mavenedmcand wilt dodhisy

= Run the following Maven command and replace the marked words by your own GX
WebManager version, presentation group, presentation na me and lcation of your
settings.xml file respectively. Use lower case characters for the group and
presentation names. Note that the command is one string, not several lines.

mvn archetype:create - DarchetypeGroupld=nl.gx.webmanager.archetypes -
DarchetypeArtifactid=webmanager - presentation - archetype -
DarchetypeVersion=  9.3.1 - Dgroupld= mypresentationgroup -

Dartifactld= myfirstpresentation - DpackageName=nl.gx.produ ct

-s .. \wm9.3.1 \ settings.xml

Please also note that you have to fill in the WebManager version that you are using with

t he p r o pDarchetypeVeésiond . I n t he above exampl e itds ver si
= VYoushould see a O6Buil d s ucc efrom thas Maden mmnmsnand gnel the
myfirstpresentation directory should be created. The directory structure is:

myfirstpresentation/src/main/..
ljava/nl/gx/product/ Activator.java
/resources/presentationtype/..
lisplpage/*.jsp,*.xml
Istatic/project/*.jpg

= Create several subdirectories in the Istatic/project directory to store the
various types of static files. For example img, css and js .
= Copy your static files from the mysite_files directory to the /static/project

subdirector y.

U

Copy the mysite.html file to the ../jsp/page/ directory.

U

Rename the mysite.html file to mysite.jsp

U

Move the existing page.jsp and page.xml files away from the WCB, but keep them
saved for later inspiration when you are working on your own mysite.jsp document.
Move them for example to yo ur Desktop.
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2.3 STEP 3 o6 Convert the HTML to JSP

JSP files contain the websiteds HTML c¢ o dWebMapager al s o func!
dynamically on the page. This allows, for instance, placing a code in the JSP to print a paragraph
or an i magedf6s URL.

These functions originate in the GX WebManager API (Application Programmer Interface). This API
can be used in the JSPs using ataglib. This taglib has to be imported at the beginning of the JSP.

Each GXWebManager JSP file has an associateddescriptor fi le. This descriptor file is an XML file
that contains more information about the JSP file. It contains, for example, the name, a
description, and possible additional dynamic parameters such as presentation properties (more
information about these propertie s will follow).

Note: <WM home> refers to the path of the GX WebManager installation folder. This path is
different for each installation.

Actions:
= Open the mysite. jsp file in Notepad or any other text editor.
= Open the <WMhome>\ webmanager - webapps \ webmanager - backend -
webapp\ target \ webmanager - backend - webapp- 1.0 - SNAPSHOVYWERB

INF\ project \ nl.gx.product.wmpcommunityeditionstyle \ page\ page.jsp file.

= From the page.jsp file, copy the first +54 lines, until the line that starts with
<IDOCTYPE html PUBLIC . (This code is alo shown in Paragraph 4.2.)

= Paste the copied JSP code in the mysite.jsp file above the first line in the original

HTML code.
= Create a new mysite.xml file and place it in the same folder as mysite.jsp . The XML
file should contain the following:
<presentation>
<name>mysite page</name>
<display - name>mysite page</display -name>
<scope>Page</scope>
</presentation>

= Adjust the name and display - name (it is recommended to give them both the same
logicalname). In GXWebManager pulldown menus, the display -nameshows up as an
option to select the design implemented by mysite.jsp

= Now it is time for the first deploym ent of our presentation WCB to GX WebManager. In
MSDOS run the following command in the myfirstpresentation directory:
mvn clean install -s .. \.. \wm9.3.1 \ settings.xml
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f

This command will create a target directory that contains the WCB:
myfirstpresentation -1.0.0.jar

You can either upload this WCB using the WCB management console in GXWebManager or
copy the file to the <WM  home3x work \ deploy directory  manually.

It takes maximum 30-40 seconds for GX WebManager to extract the WCB, read the
contents and the XML descriptor files and to have the presentation available. You can
check if your new presentation is available by logging in to the edit environment and
opening the Format > Presentation > [Presentations] panel. Set the scope to
Opaged and vy oyoursetv praskndaticn.e e

you dondt see your presentation in the panel

step troubleshooting tips seechapter 56 Tr oubl es hoot i ng 6.
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2.4 STEP 4 & Change the paths to dynamic paths

When saving the web page to local files , Firefox modifies the required files request (for example,
to mysite_files/myimage.jpg ). Those files should now be requested from the web server (for
instance, http://localhost:8080/web/static/project/images/myimage.jpg ). All the paths to static

files haveto be modified in the JSPs.

The method below takes care of most structural problems. The JSP code functions in the local
development environment as well as in the production environment, where the host settings can
be entirely different (and, therefore, requesting a file should be completely different).

Actions:

= Go to GXWebManager and assign the new design to a new page. Perform the following

steps:
0 Log into GXWebManager.
o Create a new page fromthe File > New > Page menu.
o Set the state of this page to O6Publishedd.
o Enter some text onthe page and an image element.
o Gotothe File > Properties > Design  menu.
0 Check theotoDerf imeetti ngs for t his[Appyped check box
o Next to O6Presentationd, s e | emysitestmh e, click me ent er e (

[Apply] and afterthat [Close]

= Preview the page: Open a new browser window and, at the front of the website, go to
the newly created page with the new design (in this stage of the process, it is possible
forGXWebManager 6s preview to act up; t hi Youiwd why a sep
probably see a page that has some characteristics of your original page, but thatdo e s n 6t
have the right stylesheet s, i mages are not shown and
youdbve added to the page.

= Modify the following line i n the mysite.jsp in your WCB.

<c:set var="staticFilesun"
value="${website.staticFil esUrl}/static/project” />

= Replace the existing paths to the style sheets with dynamic paths based on the

staticFilesUrl . For example:

<link href="$ {staticFilesUrl}/css/style.css"
rel="stylesheet" type="text/css">

= Repeat this step for each pathto the external Javas cripts.

= Modify the following line in mysite.jsp (or replace mysite_files with the real
path):

<c:set var="imageDir" value="${staticFilesUrl}/img" scope="page" />
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= Do a search and replace throughout the document and replace ="mysite_fi les" with

="${imageDir}"
= Deploy the WCB (see step 3).

Tip: Appendix 6.2.contains a batch script that quickly copies the files of your
presentation WCB to your WebManager installation. This saves time

= Check in the browser to see what the page now looks like. It should be an exact replica
of the original.

By default, the staticFilesUrl points to the /backend/web folder. A staticfilesUrl can
alko be selected in the GX WebManager setup tool (/web/setup ) f or statih &le sdurld
parameter on the [ General Configuration ] tab. But in most situations the default setting

will work fine for local development and production environments.

25 STEP 5 06 Change the content to dynamic content

The web page saved in step 1 is now used as the design for a page in GX WebManager. At this
time, however, only the static content from the original HTML code is shown. This should, of
course, be replaced with paragraphs and other GX WebManager content elements on the page.

In this step, the content of the page is removed from the JSP and replaced with a request to
GXWebManager that generates the content of the page and prints it in the JSP.

Actions:

= In mysite.jsp , locate the content (text + images) of the page saved in step 1 and
replace it with:

<wm:pagePart label="WM content" />
<wm:pagePart label="WM databasepage" />
<wm:pagePart label="WM medialtemContent" />
<wm:pagePart label="WM sitemap" />
<wm:pagePart label="WM searchresults" />
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26 STEP6 0Apply ot her wihgd i ck

After step 5, the content pagepart in the design is dynamic: The content shown is generated by
GXWebManager. To make an even bigger impact on visitors, other parts of the page can also be
easily made dynamic.

The task of an engineer working with SDK is simply making all items from the HTML design that
should be dynamic, dynamic (for example, navigations and page sections).

Examples of quick wins:
Printing the title of a page in the blue bar

In mysite.jsp , locate the title of the page (= the part between <title> and </title> ) and
replace it with:

${website title} - ${title}

Printing a navigation path
Inthe JSP, you willsee <head> somewhere ontop of the page. Following <head>, add this line:

<link rel="stylesheet"

href="${staticFilesUrl}/wm/flwebmanager/stylesheet.css" type="text/css" />

In mysite.jsp , addthe following code justabove t he 6contentd® page part

<wm:pagePart label="WM path" />

The style of the page has now changed. This is necessary because certain tags that are defined in
this style sheet will be used.

Printing the publication date of a page
To print the pageds publickeplacedr date, this code

<fmtformatDate = value="${presentationcontext.pageVersion.publicationDate}"
pattern="d MMMM yyyy" />

More information about using properties and methods from GX WebManager can be found in the
next chapter.
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3 GX WEBMANAGER JSPS

This chapter will cover the details of the 6 steps you have taken in the previous chapter. It will
explain more about JSPs and their relation to GX WebManager.

3.1 Construction of a GX WebManager page

Each GXWebManager page is connected to apresentation . A presentation is connected to its own
JSP template, used by GX WebManager to generate the HTML of the page.

A website page can be divided in one or more so-called page parts that contain different
information. Usually, there is a page part with the main content of a page (e.g., an article), a
page part with the site navigation, a page part for the page sections, etc. In GX WebManager,
each page part is connected to its own JSP file. A JSP file associated with a page part uses the
.j spf extension (Java Server Page Fragment).

The page parts needed are requested from the @&aged JSP, and the associated JSPF is used to

generate the HTML code for each page part. Fi nal |y, t he pageds HTML code is coc
HTML code of all the page parts and is sent as an HTML pe
One of the most i mportant page fdlkerconentelementbefamg@@eo nt ent 6 pa

are retrieved here. Each content element has its own presentation and, thus, also a JSP F file. The
6Cont ent 6 page part Ffideg and sombineathelgeneratedsHIMLIc&R.

A design with associated presentations and JSP files comes standard with GX WebManager. This
default design is called the Cleansite. Appendix 6.1. offers a schematic picture of the cleansite.
Page parts are also indicated. The cleansite comes in handy because it contains many t asks
already programmed. Before creating your own design, observe how it is done in the cleansite.

3.2 Presentation descriptors

To connect a JSP to GXWebManager, a presentation descriptor has to be defined. The
presentation descriptor dwritten in XML d&identifies the JSP for GX WebManager. Almost every JSP
has its own descriptor. GXWebManager reads the presentation descriptors recursively every 30
seconds and ensures that the JSP files become available in GXWe b Manager 6s GUI

A presentation descriptor for a JSPF that implements the design of a paragraph may look as
follows:

<presentation>
<name>WM textelement</name>
<display - name>WM textelement</display - name>
<scope>TextElement</scope>

</presentation >
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The XML file has the same name as the JSP; only the extension is different: .xml .

GXWebManager uses the O6scoped (in the example above 06Text E
presentations. The scope names determine for which part in GX WebManager the presentation is

intended. Possible scope names are included in the default GX WebManager presentation

descriptors. Al | scope names can also be vieweddwnilistontthee 6 Scoped pr es
[Presentation s] tab from the Format > Presentation menu.

It is possible to define several presentation descriptors for, for instance, the same element. If
more than one presentation descriptor is defined for, for instance, the paragraph, a pu ll-down list
to select one of the presentations for this paragraph element appears automatically in
GXWebManager. The names of the presentations, as defined in the descriptors, appear in the
pull-down list. This gives editors of the website the possibilt y to choose from various
presentations of every element (provided that there is more than one presentation available).

3.3 Contents of a JSP

Foremost, a JSP file (see Appendix .6.5. for an example) contains simply the HTML that is
requested. In combination with the special <% %> tag (the so-called scriptlets ), it is possible to
include Java code in the JSP. Try to avoid using these scriptlets: JSPs are designed to contain
HTML and scripting code, not Java code.

JSP directives allow the use of so-called tag libraries. To use the core functions of the JSP
Standard Tag Library (JSTL), the following directive should be placed at the beginning:

<%@ taglib uri="http://java.sun.com/jstl/core" prefix="c" %>

Technical explanation: This URI is not a real URI, but it specifies the tag library to be wused. In
GXWe b Ma n a gvebixrils, the URI tag library is mapped to the real location of the TLD (in the
<WM homex webmanager - webapps\ webmanager - backend - webapp\ target \ webmanager -
backend - webapp- 1.0 - SNAPSHOTYWEB INF \ wm tid ) path.

The prefix (in this case "c") determines the tag name preceding the colon of a request. The JSTL
core functions offer, among other things, the possibility for iteration. An example:

<c:forEach var="index" begin="1" end="5">

</cforEach>

To gain access in the JSPs to Java methods, an important object, the presentationcontext , is

added to the request. Inthe JSPs, questions can be posed to this object: 61 n which web initiative
am | ?6 or 601 n whi cThis abjec oam bhd reqaestedl ir?the JSP using Expression

Language (EL):

${presentationcontext}

The EL offers a simple way to gain access in JSPs © objects and associated methods. An EL
expression is always of the ${...} =~ form.
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The Java interface PresentationContext consists of a list of methods that can be requested in
the JSP. To see a list of all available methods and properties you will need the  API Javadoc, which
will be provided by your trainer and is alko available on GX Partnerweb. When the ZIP file is
unpacked in a folder, the index.html of the Javadoc can be opened in a browser. If, for
example, the methods of the PresentationContext object should be shown, the object can be
found in the frame at the bottom left; all of its methods will be shown in the main frame.

Methods cannot be used immediately but have to be transformed following these rules:

. Ifthe method generates a boolean, removet heisd pr ef i x.

. I f the method generates anythinggeed ser ¢ fhiaxma. a bool ean.
e Replace the initial capital letter with a lowercase letter.

e Removethe opening and closing brackets.

The PresentationContext method getWebsite() will become website , for instance. To
store the website object fromthe PresentationContext in a newvariable youcan write:

<c:set var="myWebsite" value="${presentationcontext.website}" />

To request the object ID of the web initiative you can write:

${presentationcontext.website.id}

The best way to make yourself familiar with these expressions is to experiment with printing
various properties of the presentationcontext , website and page objects, while looking the
API Javadoc. A lot can also be learned from looking at the cleansite page.jsp

34 JSP Dods and DonWdbBanager GX

As the JSP and WebManager APl alsa@onnect to other GX WebManager modules, such as the

caching mechanism it is i mportant to learn more about w t
working with JSPs. If you neglect this the performance of your site may be significantly slower

because the caching or personalization mechanisms cannot perform well with the JSPs.

GXWebManager 6s guidelines to use JSPs are the following:

e  Startevery JSPwith the JSP directive:

<%@page language="java" session="false" buffer="none" %>

e Include only those tag libraries that are necessary.

e Avoid as much as possible nonXML-compliant JSPs, such as:

<a href="<c:out value="${element.title}" />">title</a>

e GX uses JSP Version 2.0 which contains an improved version of the Expression Language
(EL), and allows the above to be written as follows:

<a href="%{element.title}'>title</a>
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The content of JSPs has to conform to the following JSP code conventions:

o http://java.sun.com/developer/technicalArticles/javaserverpages/code convention

0 http://java .sun.com/docs/codeconv/html/CodeConvTOC.doc.html

Do nsdt

Very import: d o n d $e scriptlets (pieces of Java code) in your JSP. This conflicts with

the separation of content, business logic and presentation and it may harm the caching
mechanism.

e Do n &k thai<jsp:include> tag to include a JSP, but the GX WebManager alernative:
<wm:include Ur | ur /=00

e« Donbot mi x WebManager sessions with common Java sessions
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4 GX WEBMANAGER PRESENTAT IONS

4.1 Property tags and presentation variants

In order to use styles such as fonts, images, or cobrs in a JSP, these styles have to be specified in
the presentation descriptor. This is done with a property tag under the presentation tag. This
looks as follows (using sample entries):

<property>
<propertyname>bullet</propertyname>
<display - name>Bullet</display - name>
<datatype>Image</d atatype>
<default>/static/project/img/arrow.gif</default>
</property>

Explanation of possible tags under the p roperty tag:

| Tag Number ‘ Description
propertyname required Name as it is used as identifier in the JSP.
display-name required Name as it is shown in GX WebManager.
datatype required Select fr om: 60l maged, 6Color o6,
OFr ame WoB&dl, eand, 6Stringbo, an
default optional Ifin GX WebManager no style property is connected to a
presentation property, the defaul value is used.

The ©6Color o, 60l maged, 6Font 6, and O6Buttond drama types
GXWebManager. The 61l nteger o, 6Stringéo, and ©6Booleand dat a
further without intervention of Java code.

The standard GXWebManager content JSPF contains two presentation properties that specify the
range of the elements t o be printed as they relate to the separators. This is not (anymore)
configured for the 6Contentd presentation model

The O6FrameWor kd data WeglpRamddewsf usmegorGK on a JSP page,

data type allows passing on a GX WebManager mge object tothe JSP

The procedure to define a property:

Go to the Format > Design menu.

Select the [Presentation] tab.

Select the presentation that needs the properties set.
Create a presentation variant.

o s> R

Configure the desired properties.
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